[image: image27.emf]
1: Accessing Scran and Getting Started
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Most schools in Scotland now offer automatic access to Scran via IP authentication.  From any computer in your school, go to www.scran.ac.uk and you’ll see a drop down list of schools.  Choose the school you are in, then click “go” – no user name or password needed.
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(If the drop down menu does not appear, contact us for your school’s user name and password.)
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©cleared for educational use. Many more free resources on site. www.scran.ac.uk
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Home access for GTC-registered teachers
As a GTC-registered teacher, you can register for free Scran access from home.  Go to www.scran.ac.uk/shop/teacher.php and fill out the online form fully, choosing a password.  Details of your home licence will be emailed to you. 
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(In addition you and your students can use your Glow log-in details to get access to Scran from home--click on the “log-in using Glow” link in the right column)
· Browse the Schools Home Page

Follow the links on this page to see the highlights of Scran’s collection organised by subject and level.  You can find much more by searching the database (see below).
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· Search the Scran database

On any page, locate the Search Scran box at the top right of the screen.

Click in the box and type in a search term.  A single word, or a name or a short recognised phrase gives the best results.  Click Go to search.  Use the Advanced search option to filter results.
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When you see the search results page, click on a small thumbnail image to display the record (larger ‘postcard’ size image and text).  Click again on the postcard image to see the full size image (this opens in a new window).
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Browse Pathfinder Packs

Pathfinder Packs are ready made collections of images, many with informative text and/or attached teaching resources.

From the navigation menu on the left side of the page, choose Resources and then Pathfinder Packs.

Choose a theme and then a topic, and then choose a Pathfinder Pack from the list.  When you view your Pathfinder Pack, click on the thumbnail images to get to the full record.  Many Pathfinder Packs include teaching and learning materials.  Blue links to these are shown at the top of the Pathfinder Packs.
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2: Using Scran Images – Downloading, Editing and Creating
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· Use the Scran Create tool to make a worksheet in a few easy steps
Click on the Create link underneath any image (on either the thumbnail or the postcard sized image).  A new window (or tab) will open.  Click “OK” to confirm your selection.  
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Scroll through the available templates and choose one by clicking the circular button beside it.  Click the OK button on the right (you may need to scroll along to see the OK button if you have not expanded the window).

Enter the text for your creation and click the OK button.

Your Creation is ready.  Click the View PDF button and your Creation will appear in a few seconds.  

You can print or save your Creation: use the File menu in the new window which opens.  If you want to save your Creation in your “Stuff”, click Store in Stuff, give it a name and click Save.  The work you have done will be stored under the “Create” tab in your Stuff (see sheet 3 for more information about “My Stuff”).
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· Copy and paste into Microsoft Word or PowerPoint 

Have a Microsoft Word or PowerPoint document open and ready.  Find the Scran image you want and open the Full View.  Right click (Ctrl-click on a Mac) on the image and choose to Copy it.  Switch to your document.  Right click (Ctrl-click) again in some white space in your document and choose Paste.  The picture will appear. 
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· Edit an image in Microsoft Word or PowerPoint etc

Remember you can edit an image from within Word or PowerPoint. Double-click on the image and this box will appear:

Click on “Layout” tab at the top, then on the box which says “Square”, then click “OK”.  This will allow you to move your image around the page freely (just click on it and hold, then “drag” it with your mouse).

Click and drag the “handles” at the edge to enlarge or shrink the image.  

To edit the picture more, use the options in the Picture Toolbar:
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3: “My Stuff” – Register, Store Images, Create Albums
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· Open, register and log in to My Stuff 

The first time you use My Stuff you’ll need to register. Click the My Stuff Log In link on the right of the page (or use the link in the left hand menu).  Register for Stuff on the next page that opens.  

Choose a user name and password for yourself: make a note of your details below and then use them to log in.

    My Stuff user name:




My Stuff password:


· Store a single image 

Switch to the main Scran window as described above.  Find an image you would like to store and click the Save link just below it, then click on the Save to Stuff Scrapbook option that opens up immediately beneath. The Stuff window will ‘pop up’ and you will see the image stored there in the Scrapbook folder. 
n.b. You can save sound and video clips in exactly the same way.

· Create an Album
You can also create collections of images called Albums.  Click the Albums tab in the Stuff window and type a name for your album in the “Album Name” box. Then click “Create Album”.  


Click “OK”.  It will tell you that you have no images in that album yet.  Switch back to the main Scran window (see above) then search or browse for an image you want to add to the album.


Once you find an image, click the Save link just below, then select the Save in Selected Album option which opens up under the Save link.

 Your Album will pop up and show you that the image has been added.

You can keep adding images to that album.  If you want to create a new album, simply click “Close Album” at the top of the album you have open, then create a new album, using the steps above.


4: “My Stuff” – Using Albums


· Views Menu
Albums are automatically shown in Standard View, with thumbnails displayed horizontally.  You can display different Views by using the drop-down menu.  
· Pictures only shows you all the thumbnail images in your album, without text;

· Worksheet shows you the thumbnail images on the left and accompanying text on the right (see below for how to edit text!);

· Slides shows you the images in a simple slideshow, with accompanying text;

· Stuff returns you to the keeps an album without closing the album you’re working on.

· Editing Albums
When you store an image in your album, it will automatically store the accompanying text from the Scran record.  You can edit this text, which means that when you display the album as a worksheet or a slide show, the text that you choose will appear.  Click “Edit” under the thumbnail image in the Standard View of the album.  This will bring up a box of text which has come from the Scran record.  Delete any text that you don’t want and type in any that you do.  Then click “Save” at the bottom. 



· Tools Menu


You can also use various tools within your albums.  You can see these options using the Tools menu. Click on the drop down menu to see the options. 

· MultiCreate allows you to convert the images in the album into a multi-image document (see next page);

· Create Website allows you to download your album as a mini-website to view off line;

· Add Text Item allows you to add a piece of text into the album;

· Reorder allows you to change the order in which the images are displayed;

· Copy allows you to send you album directly to another Stuff user. You’ll need their Stuff user name – just follow the simple online instructions;

· You can also Rename or Delete the album.


· Store Other Items

You can store Searches, Notes and work that you have done using Create and MultiCreate (see next page) in your Stuff too.  They will be stored under the appropriate tabs.


5: Using “MultiCreate” and Getting Help with Scran


· Using MultiCreate

Once you have created an album, you can convert it into a multi-image document in a few easy steps using the Scran MultiCreate tool.

Start by opening the album you want to use.  To do this, just click on the album’s name, or on “Open” next to it.


Select “MultiCreate” from the drop down Tools menu.

Click “OK” to confirm you want to use this album in the MultiCreate Tool.  A new window (or tab) will open up.


Scroll down through the templates and choose which one you want to use.  Click on the little circle beside a template to select it.


Follow the simple online instructions to add text and choose various options.  For example, if you have chosen the booklet template, you can edit the accompanying text or choose to omit some images / pages.

Once you have finished choosing your options / editing text, scroll down and click “OK”.

Click “Download PDF” to view your finished resource.  Or give your MultiCreate a name then click “Save” to store your work in your “Stuff” (it will be stored under the “MultiCreate” tab).   

 

· Need Help? 
Click Help and Training & CPD links on the left hand menu.  Here you will find lots of help pages to keep you right.  If you have need any more help, or you have any questions or queries, please contact Andrew James on 0131 651 6816 or email him at andrew.james@rcahms.gov.uk.  
6: Going Further with Scran


· Social networking- blogging:

We’re building lots of social networking features into Scran.  Want to start a blog with your class?  Click on the Scribble link in the left-hand menu.  Log-in with your Stuff account user name and password.  

You can read what others are saying, or add your own thoughts or ideas.  People use Scribble to post their thoughts, ideas, reviews and funny stuff, but you could use it for, e.g., setting a homework task (and getting students to respond with their answers in the “comments” section), or publicising a school project.  Remember, blogging is particularly encouraged as part of the Curriculum For Excellence!  Instructions and help sheets are available on the Scribble site.


· Social networking- bookmarking:
Click Share under any Scran record (at postcard size) and you can send a link to it via e-mail, via insertion into a Scribble, WordPress or Blogger blog post, or via sites like Facebook, del.icio.us, reddit and Digg.  
n.b. you’ll need to sign up to use external services such as Blogger or Facebook


· Mapping tools:
For geographers and others, if you click Maps under a Scran record, you can look at locations associated with a record in Google Maps, Google Earth or Scran’s own mapping service.  With Scran’s maps, you can also look at other Scran records associated with the immediate area.
n.b. not all records on Scran will have the “Maps” link underneath
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· Contributing material to Scran:

You can add your own materials to Scran, so they’ll be seen and used by other Scran users. Open your Stuff account (see p. 3) and click on the Contribute tab.

Follow the instructions to contribute your materials.  You’ll need to sign up as a Contributor before you can upload materials to Scran, but once you’ve signed up, the process of contributing is straightforward.  You must add data to your uploaded materials too, i.e. a caption and any other useful information that will make it easier for Scran users to find your materials on the site.
n.b. you can only upload materials you own (e.g. photos you have taken) or for which you have permission, not materials you may have found on the internet!


� EMBED Unknown  ���





Feedback!


We love feedback. It helps us develop the Scran site. So tell us how we did today, sign up for mailings and let us know how we can improve the site in the future: 


� HYPERLINK "http://www.scran.ac.uk/survey.php" �www.scran.ac.uk/survey.php�
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Tip: maximise this window if necessary, so that you can see all the options fully 





Problems pasting into Word or PowerPoint? Try selecting Edit>Paste Special, then select Device Independent Bitmap option.





If the toolbar doesn’t appear automatically, right click on the image then select “Show Picture Toolbar”.  





Remember Stuff opens in a new window or tab (browser-dependent)�My Stuff opens in a new window.  To return to the main site and start storing things you need to switch to the Scran window.  








Top Tip: It’s best to do all your editing of your album before you convert it using MultiCreate, particularly if you are creating a booklet.  So, reorder the images in your album in the order you wish them to appear in the document, and edit the text of each image (see “Using Albums” sheet on how to do this).








 Hint: When you click “Save in Selected Album” under an image, it will automatically be added to the album you have open.  If you have none open, you’ll be prompted to choose one or create a new one.
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